
A Note On This Document

I have included this document on the CD, just in case you are unable to access my blog.

Opening Blog 

Hello and welcome to my blog, this is again a written blog, I was going to include a video 
blog however due to some problems with my Web Camera I have decided not to, there are 
however some bits of video included in the blog to better demonstrate information.

Blog Entry 1 – Introduction To Assignment

I have been asked to create a movie which runs for no more than 10 seconds (Excluding titles 
and credits), that will meet the criteria of this assignment I must show that I am able to use a 
MiniDV camera, and successfully edit the recordings with either Adobe Premiere or AVID, 
both of which will be available for my use in the University computer labs.

I believe that the film will need to be original, and my idea will need to be portrayed to the 
viewer in a very short amount of time, I however believe that 10 seconds should be more than 
enough time to tell a story.

I will also have to maintain a production blog, that outlines ideas I have had, ways in which I 
have edited the film etc, similar to the blog created in the first assignment.

After all this is done I will need to produce a 2 to 3 minute presentation, which will be shown 
in one of the lecture, or workshop sessions, I feel that for me this will be the most challenging 
part of the assignment, while I have never used a video camera before, I have much less faith 
in my ability to talk to a crowd than I do my ability to put together the 10 second movie.

As a whole I look forward to this assignment, as I enjoy creating things and having the 
chance to use my imagination (As strange as my mind may be).

Blog Entry 2 – Equipment And Software To Be Used

For this assignment I have chosen to use my own equipment, which I will be receiving for 
Christmas:

Camera Specification

Name:  Samsung VP-D361
Optical Zoom: 33x
Digital Zoom: 1200x
Microphone: Built In
Display: 2.5” LCD



Type: MiniDV
Connection: Firewire

See Also: http://www.samsung.com/uk/products/camcorder/dvc/vp_d361xeu.asp

Camera From Side:

http://www.samsung.com/uk/products/camcorder/dvc/vp_d361xeu.asp


Camera From Back:



Camera From Front

Tripod Specification

Tripod Name: Star 42
Height Adjustments: Legs extendable 2x + Additional Height Available On Centre Column
Total Max Height: 149cm
Minimum Height: 57cm



Picture Of Tripod When Fully Erect:



Computer Specification

I will be using my own computer to capture, edit and produce my film, its specification is:

Processor: AMD X2 4800+
Memory: 2048MB DDR PC3200 Cosair
Hard Drive Space: 900GB 7200rpm
Graphics: ATI X1900XTX 512MB
Ports Available: 8 USB, 1 Firewire

Software Used:

I have chosen Adobe Premier as the production software I wish to use, I plan on using it in 
the future, so feel it would be good to get use to it with this assignment.

Blog Entry 3 – Idea 1 – Ninja J, Saves The Day

My original idea was about a Ninja, I have done my story boards as a series of images as I am 
very bad at drawing:



The opening sequence would have seen a Ninja up a wall, and zoomed in on his eyes:

After this you would have heard a scream, and seen a villain running off with someone’s bag, 
and Ninja J being there would have no choice but to help, he would have given pursuit of the 
villain:



And after a fierce yet funny battle he would of gotten the bag back and have saved the day:

I thought this would be a comical idea, which could result in an entertaining film, however I 
decided against it for several reasons:

1) It would be difficult to obtain a full Ninja costume



2) I have no other actors, so being all 3 (Ninja, Villain and Victim) as well as the camera 
man could have proved to be a challenge.

3) After planning this for some time I realised It would be very hard to tell the entire 
story in only 10 seconds.

Blog Entry 4 – Idea 2 – The Day The Internet Went Down

While lying in bed attempting to go to sleep one night I had the sudden idea to create a movie 
based on a day without the internet, the inspiration is from the fact that the internet in my 
accommodation regularly goes down, and I find myself bored  if I have nothing else planned 
for the day.

It would start off with a monitor showing the words “Connection To The Internet Could Not 
Be Established”

I then want to show different stages of the day, by doing different tasks, such as watching 
TV, reading a book, tapping my hand on the desk impatiently etc.



All this to express how dull a day without the net could be for the someone with nothing else 
to do.

Blog Entry 5 – The Internet, A Good Thing? Planning

After much more thought I decided to take my “Internet Down” Idea and use it for my film, 
after much more planning I decided that I would exaggerate the idea to a large scale and call 
my project “The Internet, A Good Thing?”.

I decided to show how addictive the internet could be if people let it be, and how much it 
could ruin their entire day if it were unavailable.

I still wanted to stick with my original concepts, of the hand tapping on the desk, reading a 
book, watching TV, and so on, so I set out the following Plan:

Opening – Connection Could Not Be Established Screen
Second Screen – Hands In Head Because Internet Is Down
Third Screen – Hand Tapping On Desk
Forth Screen – Reading Book
Fifth Screen – Watching TV
Final Screen – Connection Established



I also decided early on to make my movie black and white, to emphasize more that this is a 
dark day for the subject, I want to portray that the internet going down has upset the subject 
and that they are very upset about it.

I also wanted to investigate the possibility of time lapsing the entire event and putting layers 
of film on top of each other to create a ghost like effect.

Blog Entry 6 – Test Shooting  And Editing

To begin with I shot my ideas from many different angles, until I found the one that best 
suited each situation.

I also found that I could not fit everything I wanted into the movie and have it look good due 
to its 10 second duration, for example I had to scrap the idea of flicking through the TV 
Channels as this looked bad at a high speed

I also tried my idea for creating a ghost effect, and having all things happening at once:



While this did look quite good the space in which I was filming was to confined for it to work 
well, if I had have had a bigger room then this is something I would have enjoyed working 
more on.

I tried different variations in speed, for different items of footage also, some of which you can 
see in the video blog above.

Blog Entry 7 – Edit Version 1 – Happy Ending

This film uses my original ideas, and ends on a happy note, you see a screen come up saying 
“Connection Established” and then the subject jumps into the air, just as they reach a high 
point the credits begin to roll.

This image shows the Connected screen, as you can see once this screen comes up the movie 
makes a transit from black and white to colour, this represents that the mood has changed and 
that everything is good for the subject:

This image shows the subject jumping in the air in celebration of the internet coming back 
up:



I believe that this is a nice way to end my movie, however could be seen as slightly tacky, not 
all stories have a happy ending, and I will talk more about the ending I chose in blog 9.

Blog Entry 8 – Edit Version 2 – Given Up Ending
This idea again is the same as the above but the ending is different, the subject is sat at the 
computer and decides to give up, they switch the monitor off and go to bed. As a sign of 
irony I had the internet connect right after this action.

This image shows the subject going to bed, they have just gotten up from the computer and 
given up for the day:



Again I decided not to use this edit version, simply because I felt it was not quite conveying 
my image, nor exaggerating the point enough.

Blog Entry 9 – Final Version – Shocking Ending

This is the edit I decided to use, I felt it was slightly more striking than the others. I will talk 
more about why I chose it however in the next blog entry. The ending of this story is not at 
all happy, the subject is stood with his fingers to his head, as though he cannot take any more, 
and as the screen goes black and a gunshot is heard.



In this image you can see the subject standing with his back to the camera and his hand 
pointed at his head:

Blog Entry 10 – Talking About Chosen Edit

I chose this version of my 10 second movie as I felt it best conveys my idea. It represents the 
fact that some people can become addicted to computers, the internet, games and so on just as 
easily as they can to cigarettes, alcohol etc.

I want it to express that if you let it, it can take over your life rather than being an interesting 
distraction, or a useful tool. I feel that the gunshot at the end shows this idea, and asks “How 
far will people go?”

I also wanted it to be slightly humorous, hence my over exaggeration of boredom, and the 
lengths someone would go to if they were deprived from the internet (I certainly hope no one 
would be like this in real life)

The music I have chosen is “Mad Word” I feel this fits the mood well, and the section I have 
selected fits perfectly into the 10 seconds.

I decided against recording any audio and using it in the film, as I felt this would lower the 
quality of the overall piece.



I hope that people will see this as something that is not to serious, while still getting the 
message I am trying to give.  I think that some people may be shocked while others will 
laugh.

I hope that the movie is well received, and that I have created something of a good standard.

Blog Entry 11 – Final Version’s Editing Process

Just filming is not enough, you cannot expect to put what you have done onto a computer and 
that be that, so I had to go through several editing steps to get my film looking as best as I 
could. I certainly had a task ahead of me because I filmed around 30 minutes of footage and 
out of that had to select 10 seconds.

Step 1 – Importing Video

To start I had to get my footage from the camera, as I had never done this before I was 
expecting to have trouble, however it is very simple, just like getting an image from a scanner 
for example.

First I went to File>Capture



Then I had to wind my film on the camera back and hit play, once I saw the footage being 
played on the computer I hit record:

Once this was finished a box came up “Save Captured Clip” So I gave it a name and pressed 
save:



I could then see my footage in Adobe Premier

Step 2 – Selecting What Is Wanted

My next task was to go through all the footage I had shot and take out what I want, this took 
some doing as I had to repeatedly sit through it until I was certain:

Once I had selected a specific part I wanted then I selected the Razor Tool, and started to cut 
up my film:



I repeated this process until I had everything I wanted:

Then with any remaining footage I did not want, I right clicked and cut the footage from the 
list:



Step 3 – Moving Into Order

My next task was to order my work, starting by creating bins to hold data for different 
sections of my movie:



After this I rearranged my footage into the order  I wanted it to show, and then put it all 
neatly together:

Step 4 – Adding Effects

I did not use any effects in my film other than turning my footage black and white, to do this 
I double clicked the bit I wanted to add the effect to, and then selected Effect Controls:

I then went to Video Effects > Image Control and selected Black and White:



I then dragged it to the Video Effects section and it was done:

I repeated this for all sections of footage I wished to be black and white

Step 5 – Adding Transitions

Next came adding transitions, sadly due to the length of the film I was only able to add two to 
the entire project, however without them the footage changed to quickly, and I felt this ruined 
the flow of the video.

I went to Video Transitions and found which I wanted to use, for my first transition I used 
Additive Disolve:



In order to get the transition to work, I had to move one piece of footage up to “Video 2” and 
have it overflow the footage before it. I then dragged the transition onto the footage at the end 
I wanted (In this case the beginning of the footage) I could then see again in the Effect 
Controls, and on the footage itself that it had been applied successfully, I adjusted the 
transition Duration accordingly.

I repeated this process for my second transition, which was “Dip To Black” and this is at the 
end of some footage:



Step 6 – Creating A Credits Section

I wanted to add a Credits Section to my movie, while this does not count towards the actually 
10 seconds of film, I felt it would be good to have some.

To do this I went to File > New > Title…:

I then entered the name of my titles, and pressed OK:



After this, I selected an area to write in, and typed the details I wanted to be included:



I then un-ticked the “Show Video” Button so that I did not have the video still running with 
the credits:

Next I clicked on Roll/Crawl Options,  Is selected Roll, and for the Timings I selected “Start 
Off Screen” and “End Off Screen”:



I then dragged this to the end of my film, and tested it, and it worked as intended:

Step 7 – Adding An Opening Screen

I also added 2 Opening screens, these were simply 2 different images that I created using 
Adobe Photoshop, One Being “A Jcb33 Production” and one being the name of my film “The 
Internet, A Good Thing?”

First of all I needed to import my images, to do this I went to File > Import:



I then selected the file I wanted to import and pressed Open:



After this I put them tidily into my “Opening” Bin and dragged them into my movie, in the 
order  I wanted them:

Step 8 – Converting A Movie To A Frame

I decided it would be better to convert my opening “Connection Could Not Be Established 
Screen” into an image, To do this I selected the section of film I wanted to convert into an 
image, then went to File > Export Frame:



I then Gave it a name and clicked save:



After this I imported the image back into Premier, and inserted it into my film in place of the 
original movie section:

I also used this process to print out stills from my movie for use in my blog.



Step 9 – Audio And Music

From early on I had decided not to use any audio recorded with my movie, and after a while 
searching my Music collection I found something I felt suited the movie “Mad World” I 
knew this would make it impossible for me to submit my film to www.tensec.com however 
felt that it would make my overall piece better.

To do this Imported the MP3, and placed it in the correct location:

I then placed it at the start of my movie:

I repeated the same actions for my “Gunshot” sound effect, which was recorded from 
“Counter Strike Source”, however I added this so that it plays just as the final scene fades to 
black to make the piece more effective, and to synchronize it with the film, rather than have it 
play at a random time:

http://www.tensec.com/


Step 10 – Picture In Picture

I found out that I did not have enough time in my movie for all the footage I had selected to 
be played, bit by bit, so I decided to create a picture in picture comprised of 4 different bits of 
footage, enabling me to tell more of the story in a shorter time.

To do this I first placed the 4 pieces of footage in different sections, and lined them up with 
each other:

I then selected them and went into Effect Controls, and in the “Motion” menu I scaled each 
image to 50%:



I then dragged each bit of footage into the location I required and was left with a nice end 
result:



Step 11 – Time Lapse/Slow Motion/Duration

In order to make my film fit into the 10 second slot, I had to use time lapse some of my 
footage, especial my image in image section.

I also made one part of footage slow motion, to exaggerate the frustration my subject was 
feeling, I also had to alter the duration of bits of footage to make them fit into 10 seconds.

To do this I right clicked on the specific thing I wanted to edit, film, image and sound, then 
selected Speed/Duration:



I was then able to enter either a speed or a duration, in this case I wanted it to go in slow 
motion so  I selected 75%:

In other parts of the movie I increased the speed of footage, or altered the duration:

Title 1 Duration 2 Seconds
Title 2 Duration 2 Seconds
Footage 1 Duration 2.19 Seconds
Footage 2 Duration 3.02 Seconds
Time Lapse Footage Duration 1.17 Seconds
Footage 3 Duration 1.21 Seconds 



Fin Slide Duration 1.14 Seconds
Credits Duration 6.20 Seconds
Music Duration 10 Seconds
Gunshot Duration 0.18 Seconds

The total running time of the movie was exactly 10 Seconds excluding credits and titles

Step 12 – Saving And Exporting

Finally when I was done I had to save the movie, to do this I went to File > Export > 
Move…:

I then gave my movie a name and hit Save:



Alternatively to save my movie as a different format I clicked on Adobe Media Encoder, and 
selected what I wanted to save it as.

Blog Entry 12 – www.tensec.com Submission

I decided not to submit to tensec.com because I used copyrighted music in my movie and this 
would not have been accepted, and I feel that if I removed the music it would take away from 
the atmosphere.
 
Had I have had more knowledge of audio I could have created my own music to make my 
submission to tensec.com legal, however as I lack a background in this I was unable to do so, 
if I do get chance to learn these skills in the future I will consider submitting my film 
however.

Blog Entry 13 – Video Standards

After research, I have found out that “The lowest frame rate possible to achieve a moving 
image is 10FPS” There for, I shall go slightly above this and save my playable version at 
15FPS

http://www.tensec.com/


http://en.wikipedia.org/wiki/Video

I have chosen the resolution 640x486, this does not scale down the original image to much, 
while still allowing the file to be smaller.

I have chosen a 5,000Kbps Bitrate as this is what DVD’s use, and will improve the quality of 
the movie overall.

I have made the audio Stereo, so that it will come out of both speakers at once, this will 
increase the file size slightly however I feel that it is worth it for the audio gain.

I have de-interlaced the video, as running on a standard computer otherwise would create 
images with lines running through them, if motion were to be filmed.

The video codec I chose was Windows Media MPEG-4 Video V3, I have chosen this as it is 
a standard codec on most up to date computers, and provides better quality images and sound 
than many of the other Codec’s available, while allowing a good rate of compression to 
remain.

I saved it in the Windows Media format, as this gave better quality results than Quicktime, 
etc

Video Codec: Windows Media MPEG-4 Video V3
Frame Rate: 15
Resolution: 640 x 486
Pixel Aspect Ratio: Square Pixels (1.0)
Bitrate: 5,000Kbps
Audio: Stereo
Video Is De-interlaced

Blog Entry 14 – Reflection On Project

I enjoyed doing this project as it gave me an excuse to use my new video camera, and also 
gave me the chance to be creative. I had fun filming both the 10 second movie and my blog.

I found it a challenge creating the 10 second movie because although 10 seconds seemed like 
ample time before I started this project I soon found out that you can fit very little into 10 
seconds. I have attempted to tell an entire story in a very short space of time, and feel that I 
have done this quite well.

If it were possible to change anything about this assignment I would have liked to have 
slightly longer to tell my story, 20 seconds would have allowed me to include slightly more 
and slow down the pace making it easier for the viewer to follow.

http://en.wikipedia.org/wiki/Video


I am pleased with what I have done, and hope it is up to standard, I have learnt how to use 
Adobe Premier, as well as a video camera, before I came to do this I was not even sure how 
to upload movies from my camera to my computer, however now feel competent to do this in 
the future. 

I will take what I have learnt here and use it to make more movies in the future, You Tube is 
a big place and I feel it could be a good challenge taking what I have learnt further on there.

Blog Entry 15 – Conclusion

To summarise, I have enjoyed this unit and look forward to the next one, of all the units on 
my course so far I am enjoying this, the most. It is nice to have a creative challenge where I 
can use my imagination rather than trying to solve programming problems or write large 
essays. 

I hope that I have created a piece that is of a good standard. I am pleased with the results of 
my movie, however a little concerned as to how it will be taken by others, especially when I 
have to show it to a room full of people.

Blog Entry 16 – Bibliography And Reference Section

Websites Used:

www.tensec.com

http://www.samsung.com/uk/products/camcorder/dvc/vp_d361xeu.asp

http://en.wikipedia.org/wiki/Video

Sources Used:

Lincoln University Virtual Campus

References:

In my film I used the following song:

Michael Andrews – Mad World

I also used a gunshot sound taken from the Counter Strike: Source Game

Music Used In My Blog:

Electric Light Orchestra - Do Ya

http://en.wikipedia.org/wiki/Video
http://www.samsung.com/uk/products/camcorder/dvc/vp_d361xeu.asp
http://www.tensec.com/


They Might Be Giants - Istanbul (Not Constantinople) 

Carl Douglas - Kung Fu Fighting

Blog Entry 17 – Credits And Outtakes

In This Section Of The Blog I Have Done A Credits To My Movie, And Included Some 
Footage I Did Not Use In My Final Edits.

The Internet, A Good Thing?

A Film By Jason Gunn

A Jcb33 Production

Creative Technology Assignment 2

2006 – 2007

Thank You For Watching…


